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Ron’s Ramblings 
Computer Show: At the Committee Meeting on Wednesday the 7th 
April, the Committee must make a decision as to whether or not we 
conduct the 11th Launceston Computer Show this year. 
Current thinking is to hold the Show at Riverside Community Centre on 
Saturday 21st August with setting up to be done on Friday 20th August. 
The decision will rest on several conditions 
• There must be sufficient interest from exhibitors to make a Show. 
• There must be support from Members of the Group (Incl OPEN) 
• There must be sufficient Dividers available at a reasonable price. 
It must NOT be left to the “Old Hands” (Judy, Julie, Glenn, Ivan, Myself, 
et al) to do all the work. We need other Members to design and arrange 
printing of Posters & Fliers. Contact possible exhibitors, deliver 
“Invitations to exhibit” Posters, Fliers etc. Arrange Sponsorships, and 
Door Prizes. Advertising in print and other Media will need arranging. 
Security must be booked. These tasks are not physically demanding if 
enough of us spread the load. 
On set up day, there is a requirement to move tables, chairs and dividers, 
while electrical connections must be made to each Site. 
On the day of the Show, the Door must be manned and money collected, 
and accounted for, Door Prizes must be managed and distributed, Our Site 
must be manned. 
Advertisements. Some may query the advertisement for DTP Technology in this 
issue. Raju Rowe has been a supporter of the Group and the Show for many years 
and has donated some Computer Parts which has allowed Judy to increase the 
Computers at OPEN. The Advertisement is not to recommend this Supplier over 
any other Computer Store Geoff Daw of “Another Computer Store, a past 
president of the Group, has given the Group and OPEN great assistance and is 
continuing to do so but has always wanted the assistance to be at “Arms Length” 
so that there can be no suggestion that he is trading on his previous membership 
of the Group. 
Any member may advertise in this Newsletter by submitting copy to the Editor in 
hard copy or disk.  

Ron Baker 
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OPEN Session Times 
All sessions are held at the venue at  

Studioworks, 1 Pipeworks Rd, L’ton 
Standard Sessions  (All sessions $4.00) 

TAFE eLearn Sessions    
(All sessions $4.00) 

Started 15 March 2004 – All classes now full 

Special April Sessions 

 
Family History Online 

Next Classes 
Wednesday 14th  April 1pm–3.30pm & 

Tuesday 27th   April  9pm – 12pm 
$4.00 fee     Numbers limited to 8 people 

Please register on noticeboard 
----------------------------------------------- 

Microsoft Publisher 
Next Class 
Tuesday 8th April - 1pm to 3pm 
Please register on noticeboard – Fee $4.00 
----------------------------------------------- 
Creating Greeting Cards 
Creating a special greeting card for your family or friends 

Wednesday 28th April - 1pm to 3pm 
Please register on noticeboard - Fee $4.00 
----------------------------------------------- 

Tutors Tutorial 
How to use family history CD Roms and what is 

available on the Internet. 
Wednesday 7th April after meeting. 
Special tuition for tutors who would like to  

improve their skills and provide better quality service to 
OPEN. 

----------------------------------------------- 
 

VENUE TELEPHONE NUMBER 
 
A Mobile Phone Number is now available to all 
those wishing to contact OPEN during working 
hours.  The number is  

0413 698 610 

Launceston Computer Group 
SOFTWARE LIBRARY 

Dated 1st April 2004 
 

DISK 1000 - Your Library on Disk 
Have you received your copy of Disk 1000? The disk holds a 
complete listing of programs available in our PC shareware library.  
This disk is free of charge to all new members. 
DISK COPY PRICES - CLUB MEMBERS $1.00 per disk 
 
Disk Prices - Box of 25 =  $12.00 Members Only 
CD Prices – Box of 10  = $10.00  Members Only 

Judy Hall ,Shareware Librarian   

 
AVAILABILITY OF LIBRARY 

The Shareware Library is available in-between meetings 
from the following people. Please telephone first to arrange 
a suitable time.  
The library is also available at the venue - Studioworks 
most Wednesdays 9am to 3pm. Email:  
opencomputingtas@hotmail.com 
LAUNCESTON 
Julie Hjort    Phone 6344 5686 
Flat 2,  115 Penquite Road,  Newstead   Email:    jhjort@intas.
net.au 
 
    

Monthly Workshops 
Graphics – 21st April  

Next class 
PSP7 - Editing Photographs 

Wednesday  21st April  
1pm – 3.30pm 

$6.50 fee - Numbers limited to 8 please register on 
noticeboard or call Judy 63947358 or 0428 947358. 

---------------------------------------------- 
 
 
 

Monday 9am – 12 Beginners 
Monday 1pm – 3pm 2nd Step 
Tuesday 9am – 12 PC & Mac 
Tuesday 1pm – 3pm Beginners 
Wednesday 9am –12 Beginners 
Wednesday 2pm – 4pm 2nd Step 
Thursday 1pm - 3pm PC & Mac 

Monday 9am - 12 eLearn 

Thursday 9am – 12   eLearn 

Thursday 1pm - 3pm eLearn 

Friday 9am - 12 eLearn 

Wednesday   
 7th April 

1pm on OPEN  Meeting & Tutor 
Tutorial 

Wednesday    
7th April 

7pm on LCG Monthly Meeting 

Thursday      
8th April 

1 – 3 MS Publisher 

Wednesday  
14th April 

1 – 3 FamilyHistory 

Wednesday  
21st April 

1 – 3 Graphics 

Tuesday       
27th April 

9–12 FamilyHistory 

Wednesday  
28th April 

1 -- 3 CreatingCards 
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(Continued from page 3) 

What’s Happening at OPEN 
 

OPEN Monthly Meetings  
Next Meeting  7th April 2004 at 1pm 
The monthly OPEN meeting will now be held on the 
first Wednesday of the month at the venue starting at 
1pm.   
--------------------------------------------------------- 
Bulk Buy Booklets 
We have been given an opportunity to purchase some 
booklets from Dymocks in Hobart.  The list is beside 
OPEN 10 and there is also another list with a 
description of the contents of each booklet.  Please 
print your name in the column under each booklet you 
require.  You DO NOT NEED TO PAY.  Money will be 
collected when the books arrive. 
--------------------------------------------------------- 
Printing Costs 
With the purchase of the new printer we now have 
photographic quality printing available to all students. 
At this time the cost of printing will remain the same 
but may be reviewed in the future.  Current costs 
are: 
Photocopying                                                         
                                                                 20c per page 
Printing to Kyocera Printer                      20c per page 
Printing black & white text to Canon  
                                                                               
                                                                 20c per page 
Printing text and graphics to Canon                      
                                                                 40c per page 
Printing cards or full page graphics                       
                                                                    $1.00 per page 
--------------------------------------------------------- 
Fee Alteration - $2 sessions 
A decision was taken at the last meeting to assist 
those people attending more than one class a week. 

Anyone attending a second class within the same 
week can now pay $4.00 for the first session and $2 
for each subsequent session.  
 
Please Note: Special fee excludes sessions where 
special fees apply ie Graphics. 
----------------------------------------------------------- 
Free Copy of Newsletter 
Also passed a resolution to supply everyone attending 
sessions with the current monthly newsletter free of 
charge in an effort to keep them up to date. Don’t 
forget to submit your email address if you wish to 
receive the LCG/OPEN newsletter via email. 
----------------------------------------------------------- 
Roster Details 
Make sure you check the noticeboard regularly for 
changes to the current roster and special sessions 
registrations.  You may miss out on a class if you do 
not register. You can also get a copy of the roster 
on floppy disk. Bring a disk in and ask. 
----------------------------------------------------------- 
eLearn Students 
eLearn has now started.  All those who are registered 
are asked to attend classes regularly and only attend 
on the day you are registered.  
 
If you need to attend a different class please speak to 
your tutor who can arrange this for you. 
------------------------------------------------------------ 
Second Step Classes 
(See list on previous page under Monthly Workshops) 
These classes are aimed at those people who have 
completed the beginner’s courses and would like to 
learn more.  They will take the form of individual 
subject classes and will change monthly so please 
check the notice boards for session times for these 
special classes. 
 

MS Publisher Class 
Ron Baker, editor of the LCG newsletter you are 
now reading has agreed to hold a class once a 
month for those people who wish to delve deeper 
into MS Publisher.  These classes will be held on 
the second Thursday of each month from 1pm and 
will only continue if there is enough patronage. 
--------------------------------------------------------- 
Special Monthly Meetings 

 

Launceston Computer Group 
Inc. 

1st Wednesday of the month 

Wednesday  7th April 2004 
Evening  7pm – 10pm 

 
----------------------------------------------------- 

 
Open Computer Club 

1st   Wednesday of the month 

Wednesday  7th April 2004 
Afternoon from 1pm 

Tutorial immediately after 
 Using Family History CD Roms. 

 
Shareware 

Disk# >>> 3755 <<<Category>>Com for WIN/W2000< 
FreeRip MP3 
FreeRip MP3 is a free application which let you extract audio 
tracks from compact discs and export them to Wav, Ogg Vorbis 
or MP3 audio files.  FreeRip MP3 is a free application that can 
record digital audio tracks directly from compact discs, without 
going through your sound card (this process is known as 
"ripping").  
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Another setting known as the Receive Window Size can have a far greater impact on 
optimising your Internet connection. The Receive Window dictates how much data your 
system can receive before it needs to send an acknowledgement packet back to the 
sending host. On Windows 95, 98, Me systems, this is set to 8K by default. Windows NT, 
2000, and XP systems on the other hand use a 16K window size by default. Although 
specifying a larger Receive Window size can improve performance, there is a down side. 
If you configured a 32K Receive Window, an acknowledgement will be sent after every 
32K of data is received. However, if the sender receives nothing, the entire 32K needs 
retransmitting. As such, a setting of 16K is generally preferred for dial-up connections, 
while you should consider settings of anywhere between 32K to 64K for DSL or cable 
connections. These are much more reliable, and the change can result in significant 
performance increases. 
DNS settings 
When you type a server name like www.pcplus.co.uk into your web browser, your system 
will query a configured DNS server to find the IP address associated with the name. 
Although these requests are fairly small and efficient, it’s possible to circumvent the 
process entirely by adding manual entries that map hostnames to IP addresses in your 
system’s HOSTS file, found in the Windows \ system32 \ drivers \ directory on an XP 
system, or the Windows directory on a 95, 98, Me system. When entries are placed in this 
file, they’re used instead of a normal DNS query, which can often speed up performance. 
Unfortunately, if the IP address of a server changes, you won’t be able to reach it. If you 
want to implement this tip, consider using software like TweakMASTER rather than 
editing the file directly. TweakMASTER will add entries to the HOSTS file dynamically, 
and will even update entries when necessary if so configured. 
One common problem on XP systems is associated with the way in which the DNS client 
service will cache DNS information, especially when it can’t find an entry in DNS for the 
server being sought. XP implements what is known as negative caching, where an entry 
that can’t be found will be cached for five minutes. Because of this, attempts to reach a 
site whose DNS information may not have been available will continue to fail, until this 
time has passed. To circumvent this problem (especially when you know that a server 
does exist from previous visits), you can issue the ipconfig/flushdns command from the 
command line, or implement the steps outlined on the previous page to turn off negative 
caching completely on an XP system. To view the contents of the DNS cache, use the 
ipconfig/displaydns command. 
A word of caution 
Getting better performance out of your Internet connection isn’t just about tweaking 
Windows settings – it also has a great deal to do with ensuring that your system is 
performing optimally. For best results, use the settings outlined in this article in 
conjunction with a maintenance schedule that includes regularly defragmenting partitions, 

(Continued on page 6) 

Faster connection for free  
Boost the performance of your Internet connection with our indispensable, no nonsense tips 
and tweaks 
No doubt you’ve seen the banner ads: ‘Double your Internet connection speed!’ ‘Your 
Internet connection isn’t optimised!’ There are plenty of folks trying to sell you software 
that will speed up your Internet connection. While some of the tweaks applied by such 
software can help to improve the speed of your connection, some do nothing of value. This 
month we take a look at some tips that anyone can apply when trying to optimise the speed 
of their Internet connection, regardless of whether you’re using dial-up, DSL or a cable 
connection. 
The single issue that has the greatest effect on the speed of your Internet connection is the 
method used to connect. While both DSL and cable-based Internet connections provide 
download speeds ranging from 256K to 3Mb or more, traditional modems are limited to a 
theoretical maximum of 56K. Under best conditions, this means a maximum of about 52K . 
Regardless of any bandwidth limitations, there are a number of methods to help improve 
the speed of your connection. Remember, though, that optimisation settings will result in 
more efficient performance, but understand that the bandwidth you’re dealing with won’t 
change.  
Optimised settings 
If you search the Internet for ways to optimise your Internet connection, one of the most 
common suggestions that you’ll come across is to tweak the MTU size associated with your 
connection. MTU stands for Maximum Transmission Unit, and represents the largest 
packet size that a particular technology can handle without the need to split the packet up 
into smaller pieces, known as fragmentation. When Windows creates packets with a size 
larger than the MTU, they must be fragmented. This leads to sub-optimal performance and 
an often inefficient use of the connection. Although later versions apply the correct default 
MTU to dial-up and Ethernet connections, Windows 95 dial-up connections were 
particularly prone to this issue. It used an MTU of 1,500 bytes by default, even on a dial-up 
connection. The easiest way to determine the maximum MTU supported by your ISP is by 
using the ‘ping’ command. When issued with the -f and -l options, the command will show 
you whether packets of different sizes are being fragmented. The following command will 
highlight whether fragmentation occurs, based on a specified packet size of 1,400 bytes: 
ping -f -l 1400. If the ping responds normally, try a higher MTU setting. If the ping returns 
a value of ‘Packet needs to be fragmented but DF set’ then you know you’re above the 
maximum MTU your connection supports. Play around with packet size values until you 
find the MTU associated with your connection. Changing the MTU value in the Registry 
can be difficult. Consider using a tweaking utility like TweakMASTER – detailed over the 
page – to change the value easily, or see the walkthrough below to edit the Registry 
directly. 
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(Continued from page 5) 
clearing out your Temporary Internet Files, and not running unnecessary programs over 
services while online. On the hardware side, more RAM, a faster hard disk, and a quality 
network card or modem can’t hurt either. Finally, some of the Internet connection 
tweaking packages lead you to believe that changes they make will improve performance 
when in fact, some do nothing at all. If you do venture into this territory, be sure to back 
up any changes you make so that you can restore your system to its original state should 
you not notice any performance changes at all. Better to be safe than sorry. Dan DiNicolo 

Timesaving Printer Setups 
If you have a colour printer, you probably print photos in colour but use black-and-
white mode to save ink when printing text-only documents. Making that switch 
involves traipsing through a series of windows by mouse. You click the Properties 
button next to the Name drop-down list in your application's Printer dialog box, then 
select the necessary tabs and settings, then click OK to return to the Print dialog, and 
finally issue the command to print. Even more cumbersome is going to the Printers 
folder (Start>Settings>Printers), right-clicking a printer there, and choosing 
Properties before you can get to and open a print dialog box. 
Reader Warren Broglie offers a tip to help you avoid spending a lot of time clicking 
and digging through dialog-box options: Create a separate printer icon for each type of 
print job. 
Choose Start>Settings>Printers to open the Printers folder. Double-click the Add 
Printer icon to start the Add Printer Wizard. (In Windows 2000, confirm that the 
proper port is selected.) Click Next, and navigate through the wizard panels as if you 
were reinstalling your existing printer, repeating the choices you made when you first 
installed it. Once the wizard recognises that you're installing a printer already set up on 
your system, it will ask whether to keep the existing printer driver or install a new one. 
Click Keep existing driver (recommended) and then Next. On the subsequent screen, 
type a name for the new printer icon-for example, My Colour Settings (see FIGURE 
2). This screen lets you make the named printer the default one. Click Next, and follow 
the remaining prompts to finish the wizard. 
Now you have two icons for the same printer. Right-click the one you called My 
Colour Settings, and choose Properties (or press <Alt> and double-click the icon). 
Change the settings to suit your preferences for colour printing. When you're done, 
close that Properties dialog box and open the Properties dialog box for the original 
printer icon. Adjust its settings to handle another printing chore, such as black-and-
white printing. When you're done, press <F2> and rename the icon something 
descriptive, like My Black-and-White Settings. Then press <Enter>. When you've 
named both icons properly, right-click the one whose settings you use more often and 
choose Set as default, if that option isn't already selected. Now close the Printers 
window. 
The next time you need to print, open the Print dialog box in your application. In most 
cases, the dialog box will have a drop-down list of the printers that are set up on your 
system. Select the more appropriate printer for the task at hand-for example, My 
Colour Settings (see FIGURE 3)-set any other desired print settings, and click OK. 
By Scott Dunn 
From Australian PC World © 2000 IDG Communications 

Registry performance tweaks   
Click Start, Run, type regedit and click OK. Consider using the Export option available by 
right-clicking a particular key (folder) to back it up prior to making any changes. Browse 
to HKEY_LOCAL_MACHINE|SYSTEM| CurrentControlSet|Services|Tcpip|Parameters 
and create a DWORD value called GlobalMaxTcp WindowSize. For a receive window of 
32K, set this value to 8,000 in hex or 32,768 in decimal.  
All connections will now use a 32K window size.  
Browse to HKEY_LOCAL_MACHINE|SYSTEM| 
CurrentControlSet|Services|Tcpip|Parameters| Interfaces and determine which folder is 
associated with the connection you wish to change (the IPAddress entry provides a clue). 
Change the value associated with the MTU to your preferred value.  
Browse to HKEY_LOCAL_MACHINE|SYSTEM| CurrentControlSet|Services|Dnscache| 
Parameters and create three new DWORD values: NegativeCacheTime, NetFailureCache 
and NegativeSOACacheTime, all with a value of 0. This will disable negative DNS 
caching.  
Browse to HKEY_USERS|.Default|Software| Microsoft|Windows|Current|Version|Internet 
Settings and create two DWORD values: Max ConnectionsPerServer and 
MaxConnectionsPer 1_0Server. Give each a value in decimal that relates to the number of 
simultaneous HTTP connections.  
Browse to HKEY_CURRENT_USER|Software| 
Microsoft|Windows|Current|Version|Internet Settings and create the same values outlined 
in step 5. This setting will apply to the current user only.  
Reboot your system and log on to have all your changes take effect.   
This article first appeared in PC Plus Issue 212 - February 2004  Please note that the 
information contained within this article is correct at the time of creation. Information may 
have changed since the appearance of this article in the magazine or website.  Copyright 
Future Publishing Ltd   
Future Publishing Ltd, 30 Monmouth Street, Bath, BA1 2BW, England. Tel: (+44) 01225 
442244   
Reproduction in whole or in part without written permission from Future Publishing is 
prohibited. This material is for personal use only. 
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Computers can only use ones and zeros. They have to do everything that way, 
and the electrical currents are either on or off. Without going into the mysteries of 
electrical engineering, (hey, this is supposed to be Newbie-Speak, not Geek-
Speak!) let's leave it at that. 
The point: binary digits is what we're speaking about. Binary... Digits... shorten 
that to... Bit. See the relationship? A 'bit' is a Binary Digit. Take the 'B' from 
Binary and the 'it' from Digit and make a new word. 
So, now you know. One bit is a zero or a one. It takes 8 of those zeros and ones to 
make a byte. Here's a byte: 
01101001 
And one byte equals one character you type on your keyboard. This newsletter 
has LOTS of characters. Let's say it has a thousand characters just for fun. That's 
1,000 bytes worth of characters. 
Okay, sizes are interesting. And since you're faced with making decisions about 
your own computer every day, and how much stuff to store on the machine is one 
of those decisions, I hope this tutorial has given you a little insight. And that it 
was actually UNDERSTANDABLE. 
Hmmmm ... 
Dog bites. If you paid attention to the title of this tutorial, you know that the last 
two words are 'Dog Bites'. What's a dog's teeth have to do with any of this? 
Absolutely nothing. But it helps fill this newsletter:-) 
Kwik Tip ... "Control your Mouse" 
As you move the mouse across its pad, the cursor may fly across the screen, or it 
may crawl. 
This speed is easily adjusted within the Mouse Properties dialog box. Use the 
Pointer speed slider to make adjustments. 
Start, Settings, Control Panel Double click the mouse icon. 
If the mouse pointer is moving too fast, drag the slider to the slower side. If it's 
creeping, speed it up by dragging the slider to the right, or faster side.  
Tutorial ... "Do You Hog Your Spent Emails?" 
Have you any idea how much disc space is being hogged by your received 
emails? 
I thought not. But just because you have a hard drive bigger than Texas doesn't 
mean you should clutter it up with unwanted stuff - like your attic! 
And if you have a smaller hard drive you are wasting valuable space. And 
slowing down your PC every time it boots up. 

(Continued on page 8) 

Newbie Club Tutorials 
Tutorial... "Bytes, Megabytes, and Dog Bites" 
How's your math? 
8 bits make one byte. And a million bytes make... a megabyte! So, when you 
check your computer for memory, and you see you have 64 MB of RAM, you 
know you have 64 million bytes of memory space. Or that your hard drive, which 
is described in Gigabytes, has TONS of room on it. 
Unless, of course, you have an older computer with a small hard drive. Standard 
sizes today are from 8 gigabytes to 80 gigabytes. There are smaller and larger 
drives as well. 
One gigabyte holds a thousand megabytes. And one megabyte holds a million 
bytes. Once you know the prefixes, the rest is easy. Here's a prefix list for you: 
Kilo=one thousand of anything Mega=one million of anything Giga=one billion 
of anything 
Those are the 'big three' in the personal computing arena. When you see that a 
download is "3 megabytes" in size, you know it's just a BB in a box car. The box 
car is your hard drive, and that 3 megabyte file is the bb. Or ball bearing. 
Do you have your bearings now? I think I'm getting punch drunk! 
Computers started out very, very small. Early Tandy 1000SX's had NO hard 
drive. It had 384 K of RAM. If you doubled that to 640K or RAM it was maxed 
out. It also had two big floppy disk drives. 
Then along came consumer affordable hard drives. 20 megabytes! That was a 
monster. (There was no Windows at this time.) 
Sizes kept going up and up and up... and prices kept going down. That was cool. 
Imagine what it was like to move from a basic DOS system like the Tandy to a 
wonderful picture window system like, well, Windows. It was like going from a 
horse and buggy to a horseless carriage. 
Yea, it was great. 
So, we're looking at sizes... and know that most things are measured in megabytes 
and gigabytes. The common thing is the byte. Let's ramble just a tad more... 
Computers work with electricity, right? And they store stuff in memory and on 
your hard drive. If it's in memory (RAM) then the storage is actually an electrical 
current being ON or OFF. 
If it's ON, it's given the number '1'. If it's OFF, it's given the number '0'. This is 
also called the binary number system. Ones and zeros. That's all you get. You 
have to be able to count to any number using only ones and zeros. 
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before sending it off. 
Check your Tone of Voice: 
It is very easy to come across as rude and demanding in an email. Even if that's 
not your intention. So read your message before sending it off, and try to read it 
as your recipient would. Remember, she may not know you. 
Be Precise: 
Keep your message short and to the point by all means. But ensure you have 
given all the information your recipient needs to act on your query. Especially 
when writing to a support desk. 
Ask before sending an attachment: 
Many people - especially those in business, will *never* open an attachment 
because of the risk of a virus infection. If it's important to send an attachment, 
write first for permission to do so. Even then, some will refuse to accept it - 
unless they know you extremely well. 
If you send ME an attachment there's NO way I will open it!  
Tutorial ..."Adding Shortcuts to Your Start Menu" 
When using your PC, you'll often have some open windows on screen. Without 
closing them, the Start Menu provides access to lots of programs. But let's say 
you're lazy, and want a quick click solution... create a shortcut that appears on the 
Start Menu... so you don't have to chase down the program on the Programs 
Menu! 
Windows 98 and higher makes this real easy for you. 
Using the left mouse button, click on an icon and drag it from the Desktop (your 
main screen) and hold it over the Start button for a couple of seconds. You'll see 
the Start Menu open up. 
Keep holding the left mouse button down, and move the icon up to the area above 
the "Programs" time. You'll see a dark "bar" appear. Slide the icon up and down, 
and the bar moves up and down. Release the mouse button, and the icon that was 
on the Desktop is now on the Start Menu. 
If you want the icon to be in both places, Desktop *and* Start Menu, use the 
RIGHT mouse button when dragging the icon. When you release the button, 
you'll have options... choose the option to "copy here". 
If your computer is like mine, something will freeze up. My Start Menu got stuck 
and wouldn't close. What a drag. I had to reboot the computer to fix it. 
Why these things happen is unknown to human beings, but they happen. If cars 

(Continued on page 9) 

(Continued from page 7) 
Most people save emails to read later - and never do. 
Most people read emails and don't delete them - in case they need to refer to them 
later - but never do. 
Some people organize their emails into folders for specific newsletters or topics - 
and hardly ever get around to reading them all. 
Clear out the junk from … 
Your SENT box. 
Everything, you have ever emailed out is stored in your out (SENT) folder until 
you delete them. 
Your folders. Go through them all and trash what you don't need. 
Your Deleted Items folder. Do you ever go in there to retrieve a deleted email? 
Empty it once a week. If you didn't need to retrieve something in the past 7 days, 
chances are you never will. 
How do you delete this stuff? 
Just highlight the unopened email and click the delete button on your keyboard. 
To delete a block of emails, highlight the first one, hold down your shift key and 
click on the last in the block. This will highlight the block of emails. Then click 
delete. 
DON'T FORGET ... 
After you've dumped all this stuff, it all still lies there in your 'Deleted Items' 
folder. 
Delete them!  
Tutorial ----- "Email Tips" 
Don't be rude! 
When we were young, most of us were taught the basics of good manners, like 
saying 'please' and 'thank you'. So why should an email message be any different? 
And make sure you sign it with your name. Remaining anonymous does not gain 
respect. 
Be Professional: 
Don't use lots of emoticoms when writing to someone you don't know. LOL and 
IMHO may be meaningless to many people. 
Use a spell checker: 
Most email software has a built in spell checker. The odd spelling error may be 
overlooked by most people, but an email filled with typos creates a bad 
impression. So use it. Even though it may mean spending a few seconds longer 
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thousand pixels, and 1024x768 yields 786,432 pixels.) 
Your monitor must also be capable of displaying higher resolutions. Most 
modern monitors can easily display 1600x1200 pixels. And most modern video 
cards will display true colour, which is millions of colours at that high resolution. 
You can test your system's capabilities by sliding the Screen area slider. Shove it 
all the way to the right. See what happens to the Colours section. It'll either stay 
where it is, or it will drop down in colours. '16 colours' is the lowest setting.' True 
Colour' is the highest setting. 
If you want to save your changes, click the Apply button, and answer Yes to the 
questions you'll see. You may just find a different look is better for you! 

(Continued from page 8) 
were built the same way, we'd have stop and go traffic all the time. Tutorial ... 
"How To Find The Program Behind A Shortcut" 
 Some of us are just plain curious, and like to see how things work. We all feel 
more comfortable with our computers when we get a glimpse behind the curtain, 
as it were. Removing the mystery is part of what this newsletter is all about. So 
this next tip will help you get just a tiny feel for things. 
You know what a shortcut is, but can you find the program it's referring to? 
Maybe you downloaded Keyboard Magic!, First Website Builder, or some other 
ebook from The Newbie Club and aren't sure where the file is located, but you do 
see a shortcut. Okay, it's easy enough. 
We'll use the right click method. As you'll see, right clicking reveals a lot. 
Right click any shortcut, and choose 'Properties' from the menu that appears. 
In the 'Properties' dialog box, you'll see some interesting information. The 'Target' 
gives you the path to the program. (Most programs end with the three letter file 
extension '.exe'.) The 'Start in:' line shows you the path that leads to the file itself. 
You can envision your computer as giant forest full of rabbit trails. Along each 
trail is rabbit hole. The rabbit hole is the program, and the trail is the path. The 
rabbit hole is also the 'Target'. And now you know why Netscape Navigator's 
browser uses the words, "Save Target As..." when you right click a download 
link, or any link on a web page. 'Coz the lead programmer for the Netscape 
browser was raised by a family of rabbits. :-) 
The 'Target' is always the file you want to use. And a file can be a program, a 
picture, a video, or a document. 
Tutorial ..."How To Change Your Resolution" 
Are you seeing everything at the size you want to see it? If your icons are huge, 
or way too small, you can adjust the entire way your screen looks. Here's how. 
1. Right click on a blank area of your screen.  
2. Select 'Properties' from the popup menu.  
3.  Click the 'Settings' tab on the Display Properties window. 
See the slider gizmo in the middle of the box? It'll have 640x480, 800x600, or 
1024x768 listed in the 'Screen area' section. 
Adjust the slider. More pixels means more screen 'real estate'. Lower numbers 
mean you'll have bigger icons, but less room to see your stuff. 
Your video card's abilities will determine the number of colours you can choose 
at a particular resolution. (Resolution is the total number of pixels you're 
displaying on the screen. Just multiply the two numbers: 800x600 gives you 480 

Security Updates On CD, Free 
I know that many of you may already know, but it's worth making sure 
everyone hears that Microsoft is now offering a free, ready-made CD with 
security patches for XP, Me, 2000, 98, and 98SE: 
This could be a great help for people who re-install and have a slow 
connection for downloading security patches.---David Sherman 
"The Windows Security Update CD will be shipped to you free of charge. 
This CD includes Microsoft critical updates released through October 2003 
and information to help you protect your PC. In addition, you will also 
receive free antivirus and firewall trial software: http://www.microsoft.
com/security/protect/cd/order.asp " 
Thanks, David, and everyone else who wrote in. Note that this CD won't 
get you fully up to date, but it will cover the older, most-important patches. 
I assume that the costs of the CD are being borne in full or part by t he 
vendors of the bundled AV and firewall tools. I haven't seen the CD yet, so 
I don't know how aggressively they might try to install themselves, or what 
other "gotchas" there might be. But still, it could be handy having the 
patches preassembled on CD. As long as you're careful--- read the licenses, 
and select a "custom" install, if one's available--- it's probably worth having 
the CD  
From LangaList  1st March 2003 
NOTE The editor has received a CD from Microsoft Australia and has 
implemented it on his own computers (a Windows XP & 98SE) 
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designers of the human body. One said, "It was a mechanical engineer." Just look 
at all the joints." Another said, "No, it was an electrical engineer. The nervous 
system has many thousands of electrical connections." The last one said, 
"Actually it was a civil engineer. Who else would run a toxic waste pipeline 
through a recreational area?" 
Understanding Engineers - Take Seven 
"Normal people believe that if it ain't broke, don't fix it." Engineers believe that 
"if it ain't broke, it doesn't have enough features yet"  
Understanding Engineers - Take Eight 
An architect, an artist and an engineer were discussing whether it was better to 
spend time with the wife or a mistress. The architect said he enjoyed time with 
his wife, building a solid foundation for an enduring relationship. The artist said 
he enjoyed time with his mistress, because the passion and mystery he found 
there. The engineer said, "I like both." "Both?" "Yeah. If you have a wife and a 
mistress, they will each assume you are spending time with the other woman, and 
you can go to the lab and get some work done." 
Understanding Engineers - Take Nine 
An engineer was crossing a road one-day when a frog called out to him and said, 
"If you kiss me, I'll turn into a beautiful princess." He bent over, picked up the 
frog and put it in his pocket. The frog spoke up again and said, "If you kiss me 
and turn me back into a beautiful princess, I will stay with you for one week." 
The engineer took the frog out of his pocket, smiled at it and returned it to the 
pocket. The frog then cried out, "If you kiss me and turn me back into a princess, 
I'll stay with you and do ANYTHING you want." Again the engineer took the 
frog out, smiled at it and put it back into his pocket. Finally, the frog asked, 
"What is the matter? I've told you I'm a beautiful princess, and that I'll stay with 
you for a week and do anything you want. Why won't you kiss me?" The 
engineer said, "Look, I'm an engineer. I don't have time for a girlfriend, but a 
talking frog, now that's cool." 
 

Just for Grins from LangaList 
Paul C. Jess sends along this "Understanding Engineers" item, which he got from 
one Jonathan Gates.  
Understanding Engineers - Take One 
Two engineering students crossing the campus when one said, "Where did you 
get such a great bike?" The second engineer replied, "Well, I was walking along 
yesterday minding my own business when a beautiful woman rode up on this 
bike. She threw the bike to the ground, took off all her clothes and said, "Take 
what you want." The first engineer nodded approvingly, "Good choice; the 
clothes probably wouldn't have fit." 
Understanding Engineers - Take Two 
To the optimist, the glass is half full. To the pessimist, the glass is half empty. To 
the engineer, the glass is twice as big as it needs to be. 
Understanding Engineers - Take Three 
A pastor, a doctor and an engineer were waiting one morning for a particularly 
slow group of golfers. The engineer fumed, "What's with these guys? We must 
have been waiting for 15 minutes!" The doctor chimed in, "I don't know, but I've 
never seen such ineptitude!" The pastor said, "Hey, here comes the greens keeper. 
Let's have a word with him." "Hi George! Say, what's with that group ahead of 
us? They're rather slow, aren't they?" The greens keeper replied, "Oh, yes, that's a 
group of blind fire-fighters. They lost their sight saving our clubhouse from a fire 
last year, so we always let them play for free anytime." The group was silent for a 
moment. The pastor said, "That's so sad. I think I will say a special prayer for 
them tonight." The doctor said, "Good idea. And I'm going to contact my 
ophthalmologist buddy and see if there's anything he can do for them." The 
engineer said, "Why can't these guys play at night?" 
Understanding Engineers - Take Four 
What is the difference between Mechanical Engineers and Civil Engineers? 
Mechanical Engineers build weapons and Civil Engineers build targets. 
Understanding Engineers - Take Five 
The graduate with a Science degree asks, "Why does it work?" The graduate with 
an Engineering degree asks, "How does it work?" The graduate with an 
Accounting degree asks, "How much will it cost?" The graduate with an Arts 
degree asks, "Do you want fries with that?"  
Understanding Engineers - Take Six 
Three engineering students were gathered together discussing the possible 
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Getting the Most out of Word 
By The Crabby Office Lady  
To harness the power of Microsoft Word, you know you have to go beyond cut, paste, 
and format.  
From mail merge to customized lists, you're working hard at getting the most out of 
Word — too hard, perhaps. It’s time to learn some new tricks 

.Applies to Microsoft Word 2002  
Microsoft Word is one of the most popular Office programs. People use it to draft dry and 
lengthy dissertations, create padded resumes, make greeting cards, and send flowery love 
letters. The great thing about Word is, the more you use it, the more features you dis-
cover. So I've answered some of your questions to help you learn more about the features 
Word offers.  
Creating watermarks: Don't drown in the process A watermark is a faint image or word 
that appears behind the text of a document. It's intended for printed documents, and it's 
used to identify the document status (such as DRAFT or CONFIDENTIAL) or to just 
spice up the document.  
The reader below has pulled out all the stops to create a text watermark when she could 
have just looked in Help in Word or on the Assistance Centre Web site.  
"If I want the word DRAFT or SAMPLE to be a watermark set diagonally throughout a 
page, I use WordArt and change the colours to light grey and the font size (to a very large 
size) and then I have to set it to "transparent." Then I have to set the "layout" for text to 
show on top of the object (like a watermark). This is not a "true" watermark, but it will do 
the trick. How's that for creative customizing?!?! Is there an easier way???" — Work-
around Wanda  
Dear Wanda, You're working much too hard, and you deserve a break. Take a glass of 
lemonade, go sit on the porch, and read my solution. Word has a handy little feature 
called the Printed Watermark dialog box. To add a text watermark to your document On 
the Format menu, point to Background, and then click Printed Watermark. Click Text 
watermark, and then select or enter the text that you want.  
Select any additional options that you want, click Apply, and then click Close. To view a 
watermark as it will appear on the printed page, on the View menu, click Print Layout. 
Note To add a watermark, you must be using a view other than Web Layout view. Now 
drink up and get back to work.  
Customizing views, lists, and templates When you move into a new house that has or-
ange shag carpeting and an avocado-coloured oven, maybe a little customisation is in or-
der. (And with Word, it's usually easier than picking out appliances that match orange 
flooring.)  
"Whenever I go into a new Word document in the Print Layout view, I have a page full of 
gridlines showing on my screen. I have no idea how they got there, and of course, I have 
no clue how to get rid of them." — Grumpy with Grids  

Dear Grumpy, Maybe you're not getting enough gridlines in your diet; have you consid-
ered that? Or maybe grids are the way the universe ensures that the various aspects of 
your life are in harmonious order (you know, all lined up in a grid and such). But of 
course, that is not my area of expertise, so I'll make this short and sweet.  
To turn gridlines off and stop being grumpy On the Drawing toolbar, click Draw, and 
then click Grid. Deselect Display gridlines on screen. Note If the Drawing toolbar isn't 
showing, on the View menu, point to Toolbars, and then click Drawing.  
My next reader is working much harder than necessary. Why jump in and start program-
ming when we have built-in features that will save you time and energy?  
"I transcribe court trials, and I use Word. I have my template for my page, but I need 
some help to set up a macro that repeats Q. and A., such as:  
Q. 
A. 
Q. 
A... 
.instead of  
1.  
2.  
3. or  
a.  
b.  
c. in a continuous manner. I would appreciate your assistance or your guiding me to 
someone who can help me." — Attorney Annik  
Dear Annik, Why go to all that trouble of writing a macro when we provide a feature for 
customizing lists? To customize a list On the Format menu, click Bullets and Numbering, 
and then click the Outline Numbered tab.  
Click a list format that does not contain the text "Heading" or is not a graphic, and then 
click Customize. Under the Cancel button, click More.  
In the Level box, make sure 1 is selected. In the Number format box, replace what is in 
there with a Q. (period included).  
In the Level box, click 2 to select it. In the Number format box, replace what is in there 
with an A. (period included).  
In the Level box, click 3 to select it. In the Number format box, delete anything text in 
there. Toward the bottom of the dialog box, make sure that the box that says Restart num-
bering after is selected and Level 2 is displayed in the drop-down box. Repeat steps 8-10 
for each level. In the ListNum field list name box, give your new list a friendly name 
(such as Q&A). Click OK. Now in your Word document, on the Format menu, click Bul-
lets and Numbering, and then click the Outline Numbered tab. Your new list type should 
show up there and you can use it just like you would a regular outline. On the Format 

(Continued on page 12) 
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(Continued from page 11) 
menu: Click the Increase Indent button to make a level two entry. Click the Decrease In-
dent button to start another level one entry.  
Mail merge: It's not just for the postman anymore Listen up because I'm only going to 
say this once (more): Using the Mail Merge Wizard in Word 2002 is about as easy as it 
gets when it comes to creating form letters, envelopes, directories, or mass mailings. Or, 
if you prefer not to use it, you can address 10,000 letters to your stockholders one address 
at a time. Then you can make a visit to the physical therapist  
"I want to do a mail merge but it seems Office XP does not have the "edit data source" 
button. — Editing Edith Dear Edith,  
Humph! Office XP most certainly does offer the option to edit your data source. I looked 
for it in the Mail Merge Wizard, and it just about jumped out at me! Note Before I launch 
into this, some readers may be unfamiliar with what a data source is. It's a file that con-
tains the data that you want to insert into each copy of a merged document. For example, 
your Microsoft Outlook® contact list is the data source that you want to access to address 
a bunch of envelopes. The reader above wants to be able to make a change to that list 
while in the process of doing a mail merge. If you're using the Mail Merge Wizard (on the 
Tools menu, point to Letters and Mailings, and then click Mail Merge Wizard), you can 
always make changes to the data source you're referencing by clicking...um...Make 
changes. This command opens the data source, and off you go!  
"Is there any way to print 100 envelopes with the same delivery address on them without 
having to go in and out of the envelope print screen 100 times? Please help." — One-
Friend Frieda  
Dear Frieda, Three words: Mail Merge Wizard. (It sounds scarier than it really is.) Note 
To use the Mail Merge Wizard to access a data source such as an e-mail contact list, your 
system must include a Messaging Application Program Interface (MAPI)-compatible e-
mail program, such as Microsoft Outlook. MAPI allows you to send e-mail from within a 
Microsoft Windows® application and attach the document you are working on to the e-
mail message. To create and print envelopes for a mass mailing Open a new document in 
Word. On the Tools menu, point to Letters and Mailings, and then click Mail Merge Wiz-
ard. In the Mail Merge task pane, under Select document type, select the Envelopes op-
tion, and then click Next. (Remember to click Next after each of the following steps.)  
In step 2 in the wizard, under Select starting document, select the Change document lay-
out option. Under Change document layout, click the Envelope options link, select the 
envelope size and address font options you want, and then click OK.  
In step 3 in the wizard, under Select recipients, click Select from Outlook contacts. Click 
Choose Contacts Folder. In the Select Contacts List folder dialog box, click the contact 
list you want, and then click OK. All of the contacts in the folder appear in the Mail 
Merge Recipients dialog box. Select the names you want to include and click OK. Com-
plete the wizard. Note By default in the Mail Merge Wizard, your return address is omit-

ted. If you want to print your return address on the envelope, add your return address to 
your envelope in step 4 or step 5 in the Mail Merge Wizard. The wizard will take you 
through the steps and, for the last step, the Print dialog box will pop up and you'll be able to 
select how many copies of each envelope you'd like to print! For other tasks you can ac-
complish with mail merge, .  
Images, drawings, and artsy-fartsy stuff Sometimes you need art and just don't know it. 
And sometimes you have more art than you can handle. "I know that I can change the di-
rection of my text, but how can I get it to print upside down? I can get it to go left vertical, 
right vertical, and almost every other way, but not completely upside down. Is there a way? 
Please, please, please help me!!!!" — Acrobatic Angelina  
Dear Angelina, The only way you can print text upside down is to use the WordArt feature. 
To print upside-down text using WordArt On the Insert menu, point to Picture, and then 
click WordArt. Double-click the type of WordArt you want to use. Edit the text, and then 
click OK to insert it into your document. Select the WordArt object. On the Drawing too l-
bar, click Draw, point to Rotate or Flip, and then click Flip Vertical. Note If the Drawing 
toolbar isn't showing, on the View menu, point to Toolbars, and then click Drawing. There 
is one more option of course: You could print the document normally and then stand on 
your head to read it. (This is a special yoga pose, but I can't remember the technical name 
for it.)  
"I have set up more than 500 Word templates with headers that have an obsolete image, 
which I need to replace with an updated image. Is there anyway to create a macro, which 
will automatically open each template and replace the old image with the new one." — All-
At-Once Alan  
Dear Alan, I read your mail, and my eyes started to glaze over. So I skipped down the hall 
to the office of Paul Cornell, one of our Power User Corner gurus. Here is what Paul had to 
say: "Yes, it is possible to do this. However, I am not aware of any existing macro code to 
solve Alan's problem. Basically, provided that all of the templates and the new image were 
in the same directory, Alan could write a macro that uses the Word object model and the 
Microsoft Scripting Runtime (scrrun.dll) to open each template, locate the image, delete it, 
and replace it with the new image. It is fairly straightforward, but it would, of course, re-
quire knowledge of the Word object model and the Microsoft Scripting Runtime, as well as 
Microsoft Office Visual Basic for Applications." So there ya go. Paul also recommended 
finding a developer to do this for you: Find a Microsoft Certified Partner 
From Microsoft Office Assistance 
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[del], but watch for indications of alternative keys during boot. You can normally see the 
keys that you need to press on the initial screens of the boot process. If you miss it, just 
press the reset button and try again. 
Once in the BIOS set up utility, you may be forgiven for thinking that you’ve stepped 
back in time. Few BIOS utilities support mouse control, so you navigate using the 
keyboard’s arrow keys, pressing [Enter] to select an option. Some BIOSes use [Pg Up] 
and [Pg Down] to change options, but you’ll find a summary of the control keys on this 
screen. [Esc] usually moves you back up one level, or quits without saving changes if 
you’re already at the main BIOS set up screen. [F10] enables you to quit, saving the 
changes you’ve made. With the correct tweaks to your BIOS, you can achieve significant 
performance gains. Sometimes this is achieved by overclocking, but some performance 
gains can be made just by ensuring that the most appropriate settings are chosen. BIOSes 
aren’t normally optimised when shipped, so you can make gains by confirming that your 
BIOS is correctly set for your components. 
Many motherboards have an overall option to increase speed. Some offer settings like 
Normal, Fast and Turbo. You may also find a setting like Load Optimized Defaults in 
some BIOSes. These will improve performance, but they won’t get the best out of your 
system. Only by understanding the capabilities of each piece of hardware in your PC and 
then making appropriate alterations in the BIOS can you truly push your system to the 
max. 
CPU frequency 
You’ll find the ability to change CPU speed or frequency, or the Front Side Bus, in most 
BIOSes. This may be called CPU Host/PCI Clock. The clock speed will be considerably 
slower than that of the processor itself, being somewhere between 66MHz and 133MHz. 
Increasing this by small increments is the most common method used to overclock a 
processor. Resist the temptation to increase it by larger steps as this is where damage 
often occurs. This is normally located in a section called Frequency/Voltage Control, 
although some BIOSes have separate sections for the processor. Once you’ve attempted 
an overclock, head to the PC Health section of the BIOS. This will give you a reading of 
the CPU temperature. Try to keep it below 40 degrees Celsius. If it has risen above this, 
go back and undo your tweak. 
Memory matters 
To optimise your RAM performance, open the Chipset Features section of the set up 
utility and tweak the Memory Timings options. If the memory slots in your motherboard 
use identical memory sticks, or you have just one installed, choose By SPD. Otherwise, 
find out the capabilities of your memory with a benchmarking program like SiSoft Sandra 
Max3 and set the timing accordingly. Make sure that the DRAM clock setting matches 
your setting for memory timings. 
CAS Latency (Column Access Select Latency) is a measure of how quickly data can be 

(Continued on page 14) 

The naked BIOS 
A few informed BIOS tweaks can enhance your PC’s performance and your PC using 
experience. Get ready to hit [Del]. 
 
The BIOS (Basic Input Output System) is often dismissed as being simply the glue that 
holds your hardware together, little more than a pot of your most basic settings.  
However, while an OS is far more configurable, the BIOS holds more than its fair share 
of handy tweaks, many of which can provide considerable performance gains. The 
average PC user generally feels no need to tweak the BIOS, but a power user knows that 
it holds plenty of important settings that can provide additional functions, or improve 
performance. The only costs involved are the time it takes to affect them.  
BIOSes vary greatly depending on not just the BIOS manufacturer but also the 
motherboard manufacturer. This combined effect makes it difficult to provide definitive 
instructions. Menus differ and the terms used to describe settings often change. That said, 
you’ll still find more similarities than differences between BIOSes.  
Functions may have different labels, but the end results will be similar. For the purposes 
of this feature, we’ve opted to use the Award BIOS as our main demonstration example, 
although the AMI and Phoenix counterparts offer similar functions. Even different 
versions of Award vary, so you need to exercise a little common sense when following 
instructions.  
Regardless of all these caveats, and no matter which BIOS you have, the following advice 
will help you make the most of it. 
First off, the terms BIOS and CMOS are often used interchangeably, although technically 
they don’t mean the same thing. While the BIOS is the software that handles your 
computer’s main hardware, the CMOS (Complementary Metal Oxide Semiconductor) is 
the memory used to store your BIOS settings. This is maintained by the little battery on 
your motherboard. When you make alterations to the BIOS, they’re stored in the CMOS 
until the power from the battery is cut. This may be achieved by either the battery 
expiring, removed, or by resetting the CMOS jumper on your motherboard, which 
effectively cuts the power. The latter scenario is worth bearing in mind for the future. If 
you really get in a mess with your BIOS meddling, you can reset to the defaults using this 
simple operation. Check your motherboard manual for the location of this jumper or 
failing that, take the battery out, wait 10 seconds to allow for the CMOS to clear of 
residual charge and then replace it. Be sure to use tweezers, or wear light gloves to avoid 
greasy fingerprints on the battery terminals. Bear in mind that if you do resort to this 
action, you’ll need to reset the date and time, along with your other settings. 
Setup 
To get started, you’ll need to enter the BIOS set-up utility. You do this by pressing a key 
or combination of keys as you start your PC. For most BIOSes this is just the delete key 
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read from memory. This is measured in clock cycles and its value is normally 3. 
However, some faster memory has a CAS latency of 2. It’s worth trying out setting the 
CAS latency time to 2 to see if this improves performance, but be prepared to switch it 
back again if instabilities arise. 
AGP slot 
While your motherboard and graphics card may both support AGP 4x or 8x, performance 
will suffer if the AGP mode in the BIOS is set to a lower value. Ensure this setting 
matches the maximum your hardware can handle. The AGP aperture size is the amount of 
system RAM allocated to the AGP for video purposes. You can set this to up to half of 
your system RAM. Some BIOSes permit you to enable AGP Fast Write Transaction. This 
works on AGP slots that support 4x and 8x, allowing data to be sent directly from the 
chipset to the graphics card without making a copy in system memory for the graphics 
card to fetch. AGP sideband addressing permits some cards to request data at the same 
time as receiving it. This improves performance but can produce instabilities with some 
graphics cards. 
In newer systems, disable system BIOS, video BIOS and Video RAM Cacheable are all 
settings that copy data into the L2 cache. This would improve performance if Windows 
used this feature. With them disabled, you preserve the L2 cache for other use. Equally, if 
you don’t play graphic-intensive games from DOS, you can disable Video BIOS 
Shadowing and Video BIOS Cacheable because recent versions of Windows (2000, XP 
and above) don’t take advantage of these features. 
Better boots 
More often than not, hard drives are automatically detected. However, you can save some 
boot time by setting the IDE drives to User and then manually specifying the drive 
parameters. These can seem a bit complex and daunting, but you can find most of them 
printed on the drive itself. Some BIOSes have a separate Detect IDE utility that you can 
use to retrieve the relevant information. Some older BIOSes don’t automatically detect 
hard drives and therefore require you to enter the specifications manually anyway. Here’s 
a quick guide to hard drive specifications used in the BIOS. Size is generally a measure of 
the number of heads, sectors and cylinders. You should find the number of cylinders 
printed on the hard drive label, and the same goes for the number of heads. Write 
Precompensation will be determined automatically so don’t worry about it. Ignore 
Landing Zone or set it to zero. It’s used for older drives that don’t ‘auto-park’ their heads, 
but all modern hard drives have it. Sector indicates the number of sectors per track. If this 
isn’t indicated on your drive, try 17 and 26, which are common settings. 
You can save time when booting your PC by enabling Quick Boot or the Quick Power On 
Self Test. You’ll find this in the Advanced BIOS features. With today’s huge RAM sizes, 
any test that involves a RAM count takes ages. If necessary, you may need to disable the 
RAM test separately. It’s also worth turning off the Boot Virus Detection, as this should 
have been covered by the use of an up-to-date virus checker. 

The boot sequence determines the device that’s first used to start up your PC. A common 
sequence starts by interrogating the floppy drive, then the CD drive and finally the first 
hard disk. You can speed up this process by setting the primary hard drive as the first 
boot device, thus bypassing checking the floppy and CD drive for boot records. However, 
it’s useful to boot from floppy or CD at times, but you can edit the BIOS to enable 
booting from these. Note that modern BIOSes can enable booting from USB or FireWire 
devices, as well as Zip and LS120 drives. You can speed up the process by setting 
unwanted boot devices to None.  
Peripherals and ports 
There’s more to BIOS tweaking than just improving performance, although a speedy PC 
is usually a happy one. Management of your peripherals, including your serial, parallel 
and USB ports, provides you with greater control over your hardware. The Integrated 
Peripherals section gives you access to a number of changes that you can make to your 
ports. If you use a parallel port scanner and run a printer from this port, you’ll want to 
ensure that it’s bi-directional. There are four options for the parallel port. The first is 
Normal or SPP. This is bidirectional but very slow. ECP (Extended Capabilities Port) 
works well for devices that transfer lots of data. EPP (Enhanced Parallel Port) is better for 
devices that switch data direction a lot. Some offer a mode called EPP + ECP. This offers 
the best of both worlds, although it takes up two IRQ (interrupt requests) and this may be 
significant if you have a lot of devices permanently hooked up. You may find a setting 
named ‘ECP mode use DMA’. This controls the DMA (Direct Memory Access) channel 
used for ECP transfers. It’s 3 by default, but you can change it to 1 in case of a conflict. 
Enable or disable the serial ports using the Onboard Serial Port settings. The defaults set 
IRQ 4 with 3F8 (a reference to a memory address in the lower portion of the memory 
map) to COM 1 and IRQ 3 with 2F8 for COM 2. If you disable either of these, you free 
up the IRQ that’s associated with it. Also often included in the Integrated Peripherals 
section is the USB controller, where you can enable or disable your motherboard’s 
onboard USB controller. You may also find USB keyboard and mouse settings here. 
While Windows will probably handle these, you may want to ensure that USB keyboard 
is enabled if you want to use it in DOS or in the BIOS set up utility. 
The Onboard IR Function setting is for enabling IR devices connected to the 
motherboard. Use the setting indicated in the documentation for your infrared device. 
You may find duplex settings for the IR port here, so you can choose between full and 
half duplex transfer modes. 
Power management 
Power management features may hit performance but they save energy and help 
safeguard the future of the planet. Most involve shutting down parts of your system after 
a certain amount of idle time. There are several power-saving states that a PC can enter. 
Dozing slows the processor down to around half normal speed. Standby shuts down the 
hard drives and graphics output. Suspend closes down all devices except the CPU. 
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Inactive shuts down the processor and powers down the L2 cache. HDD power down 
shuts down the hard drive. Change the PM Timers to set the waiting period before the PC 
powers down its hard drives or goes into Suspend or Doze mode. Choose Power 
Management from the main BIOS set up menu. If you have a Global Power Management 
setting, set it to Enabled. Other settings enable you to specify what components power 
down when the system is idle. Select the Power On Function to specify what action will 
restore power. You can assign this to a hotkey or password, or opt to restore power when 
any key is pressed. You can also set your PC to wake up at a specified time on receipt of 
a signal from an attached device or from the local network. Enable Wake on LAN or 
WakeUp by PME# of PCI to set these up. 
PC Health 
After all your fiddling, you should find that your PC boots up faster and is less wasteful 
of resources. However, this only required changes from generic settings to those more 
specific to your system, and will subsequently have had only a minor effect on your 
overall system performance. Tweaks to clock and timings will have had the greatest 
effect, but be sure to check your PC’s healthy before you assume all is well. This is 
exactly what the PC Health section of your BIOS enables you to do. CPU and system 
temperatures as well as fan speeds can be found here, which is the best way to check if a 
tweak takes the temperature too high. You can also set levels at which the BIOS can take 
action to preserve its components. CPU Warning Temperature enables you to set a level 
at which you’re warned when things are getting too hot, and CPU Shutdown Temperature 
allows the BIOS to shut the processor down should you not take heed of the previous 
warning. It’s better to be safe than sorry. Joe Cassels 

The at-a-glance guide to the set-up utility 
1. Standard CMOS Features 
This contains basic settings like system time  and settings for hard drives, floppy drives 
and  CD/DVD drives. It’s the most commonly configured  area of the CMOS set-up 
utility.  
2. Advanced BIOS Features 
This contains advanced configurations, like SMART capability, RAID settings and Boot 
virus protection. Use this section to alter your boot device order. 
3. Advanced Chipset Features 
You can make various chipset alterations here, including DRAM timing, the Video BIOS 
setting and several configurations of the AGP port. 
4. Integrated Peripherals 
This section controls the various ports of the computer, including IDE, USB, Serial and 
Parallel ports. You’ll also find settings for onboard infrared, sound, video and 
networking, if present. 
6. PnP/PCI Configuration 
You can alter settings for the motherboard’s PCI slots here, and tweak its plug-and-play 

 

capabilities. 
7. PC Health 
This section shows you statistics like the processor’s temperature and fan speeds. You 
can elect to shut down if the processor exceeds a set temperature.  
8. Load Fail – Safe Defaults 
This quickly returns you to a working configuration. 
9. Load Optimized Defaults 
Returns to defaults, with enhanced performance. 
10. Set Password 
Specifying a password here will lock anyone who doesn’t know it out of the set-up utility. 
If you have separate user and supervisor passwords, the user password only allows power 
on access. You need the supervisor password to access set-up. 
11. Save and Exit Setup 
Quits the utility, saving the changes you’ve made. 
12. Exit Without Saving 
Quits the utility, undoing the alterations you’ve made. 
Getting Flash 
You can get newer features and greatly improve your ability to control your system by 
upgrading your motherboard’s BIOS. You can update your motherboard’s BIOS if there’s 
an update available and if your motherboard uses Flash EPROM to hold the BIOS. If this 
is the case, you could improve your ability to control the BIOS by making the upgrade. 
However, bear in mind that if you unsuccessfully flash your BIOS, you can end up 
 with a PC that doesn’t work at all. If you don’t  need to upgrade your BIOS, consider 
sticking with what you’ve got on the ‘if it ain’t broke, don’t fix it’ principle. 
 AOpen motherboards include a system called Die Hard BIOS, whereby a permanent 
back-up of theoriginal BIOS is held on the motherboard.Consult your motherboard 
manual for more details or head to www.aopen.com to get hold of Die Hard BIOS Lite, 
which enables older AOpen boards to be rescued after an unsuccessful flash. BIOS 
saviour may be of interest to those with motherboards from other manufacturers. It costs 
around £30 and enables you to test a new BIOS before permanently upgrading your 
system. Take a look at www.bios-upgrade.co.uk/bios-saviour.htm for more details. 
 This article first appeared in PC Plus Issue 213 - March 2004 
Please note that the information contained within this article is correct at the time of 
creation. Information may have changed since the appearance of this article in the 
magazine or website. 
Copyright Future Publishing Ltd 
Future Publishing Ltd, 30 Monmouth Street, Bath, BA1 2BW, England. Tel: (+44) 01225 
442244 
Reproduction in whole or in part without written permission from Future Publishing is 
prohibited. This material is for personal use only. 
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@ The battle for our inboxes 
According to statistics from email filtering companies such as Brightmail 
and MessageLabs spam now makes up, on average, over 50 percent of 
email traffic. That percentage is rapidly increasing. 
If you've been sitting around waiting for the perfect spam tool or the 
perfect anti-spam legislation to appear, save your derriere. Spam is a 
moving target, technologically, geographically and socially, and no single 
solution is going to stop the flow any time soon. 
That doesn't mean you should throw up your hands, abandon email and 
give in to the spammers. It merely means you need to find an interim 
solution that makes spam manageable, voice your support for anti-spam 
technologies and policies, and stop buying products advertised via spam. 
Despite the increasing flow of spam, there are some signs of hope. The 
recent trend towards spam that appears to contain nothing but gibberish is 
one indication that spammers are starting to feel the pinch. That gibberish 
is an attempt by spammers to sidestep Bayesian filters (more on this 
below). 
The money being poured into anti-spam technologies, too, is helping to tip 
the scales of the technology battle between spammers and spam blockers. 
The realisation that spam could not only cripple email - a tool the world 
has become all-too-dependent upon - but also cause a significant strain on 
the Internet itself is impetus enough to get the really big guns working on a 
solution. The solution's not there yet, but serious money is being poured 
into finding one. 
Whether, as Bill Gates asserted recently, spam will vanish within the next 
two years... well, let's just say I'm not putting my money on it, certainly 
not based on the solutions proposed by Mr G. And I wouldn't put too much 
faith in CAN-SPAM legislation, either. Remember, CAN-SPAM comes 
from the same bunch of people who designed anti-telemarketing 
legislation which specifically exempts their own telemarketing campaigns; 
it also undermined stronger anti-spam legislation already introduced in 
California. In fact, unless a global political strategy emerges which 

emphasises the value of privacy over commerce (and how likely is that to 
happen?), all anti-spam legislation appears doomed to be little more than a 
Band-Aid placed on an arterial rupture. 

@ Choosing your technology 
Even if Bill Gates proves correct and spam disappears by 2006, that's two 
years too long than I'm prepared to wait, and I'm sure most of you feel the 
same. 
So it comes down to choosing from existing spam blocking technologies. 
Fighting spam solely through technological methods results in an 
escalating battle: The anti-spammers develop a tool to block spam; the 
spammers respond with a new twist which successfully defeats the tool; 
the anti-spammers add another approach; again the spammers develop a 
new wrinkle to avoid detection. And so it goes. 
For us, this escalating battle means we need to regard anti-spam tools 
much as we do anti-virus tools: They're only as good as their last update, 
and a multi-pronged approach is likely to provide the best defence. 
Many of the most recent programs incorporate a range of technologies, 
recognising that no single technology stands a chance in the face of the 
rabid cunning of the spammers. Also keep in mind that an over-zealous 
spam blocker can be a real problem as it blocks messages you want to 
receive - the blocking definition of spam might not exactly match your 
needs. 
In the coming issues, we'll look at the range of anti-spam technologies and 
options available to individual users and give the nod to the spam blockers 
we at Woody's Watch have chosen in our own anti-spam battles. 

@ Spammerwocky 
So, what's with all these spams which appear to contain nothing but 
gibberish? It's as if Lewis Carroll had turned his hand to penning spam, but 
unfortunately the result is nowhere nearly as entertaining as his 
Jabberwocky. 
We've received email from lots of readers wondering what on earth is 
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(Continued from page 16) 

going on. After all, it's one thing to get a spam whose subject reads "Get 
your FR3e V-Y-@-G-R-@", quite another to get a message which consists 
entirely of nonsense. The former is clearly an attempt to evade simple 
spam filters that search for trigger words and phrases. But what can the 
latter hope to achieve? 
Take a look at one of those spammerwockies. You'll probably find an 
image or a one-line sales pitch lurking within. That's what the spammer 
hopes you'll spot (and respond to). And it's what the spammer hopes your 
spam-blocking software will fail to spot. 
All the rest of the message - the nonsense words and phrases - is an 
attempt to fool both simple pattern-matching filters and the far more 
sophisticated Bayesian filters. Bayesian filters look for spam-like subjects, 
words and phrases and balance those spam indicators with 'anti-spam' 
indicators in the same message. This holistic approach judges each email 
in its entirety, instead of simply blocking on the basis of trigger words. 
The spammerwocky tries to sneak through the filter by subsuming its core 
message within an apparently 'benign' context. 
The technique works - sometimes - but only when the content of the spam 
is so thoroughly disguised it almost makes no sense to send it. Still, some 
people click on links in this type of spam, and that's enough to keep the 
spammers' hopes alive. 
At some point, though, the pay off - those who will click even an 
entirely nonsense message - is going to be so small spammers will be 
defeated, at least on this front. That's why those spammerwockies are 
a welcome sight: they are an indication that at least in one section of 
the battle against spam the blockers are getting the upper hand. 

@ Outlook Today customization failure 
[Outlook] 
WEEer J.G. writes: 

A short time ago I did a clean install of my entire hard drive. In 

preparation for this I saved all my Outlook 2000 file folders and 
noted the settings I had changed over time. When it came time to 
reinstall Microsoft Office 2000 (including Outlook 2000), 
everything went along without a hitch. However, I think that at 
some point while setting up the starting screen for Outlook I 
inadvertently selected a theme and now I cannot seem to be able to 
change it. Every time I try to click on the "Customize Outlook 
Today" button, nothing happens. In the past, I relied heavily upon 
the Outlook Today screen to track my upcoming appointments, etc. 
Any assistance you may be able to provide would be greatly 
appreciated. 

Chances are it's not the act of choosing a theme that has caused your 
problems. More likely you've fallen afoul of a patch for Internet Explorer 
known to disable the Customize Outlook Today button. The culprit is 
Critical Update 813489 for Internet Explorer. Microsoft has a workaround 
for the problem, but the workaround partly disables Critical Update 
813489, leaving your system open to what's called an "information-
disclosure vulnerability" (that's Microsoft-speak for a big hole someone 
can use to spy on your interaction with a Web site). 
The workaround involves adding a new DWORD value to your registry. 
Don't try this if you're unfamiliar with registry editing. Probably the best 
thing to do is to add the DWORD value, make any changes you need to 
make to Outlook Today, and then remove the DWORD value. The 
Microsoft Knowledge Base article details a method for exporting the 
DWORD value. If you follow the steps in this section, you'll be able to 
create two registration files which will let you automate the process of 
adding the DWORD value to your registry and removing it from the 
registry. 
From Woody’s Email Essentials 2.03  27th February 2004 
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More clues for healthy 
computer use Brian Plush  

Haven’t you looked at Clues for Healthy Computer Use yet? Come 
on, it’s in the CD library. And don’t think I haven’t noticed no one 
has borrowed it since my first stunning article.  
Last month we looked at some easy exercises we can use to help 
avoid headaches, stiff necks, sore shoulders and backs. This time 
we’re looking at what we can do with our arms, wrists and hands. 
Remember gentle exercise, five to ten times every hour is the way to 
go as you are not training for a Full Forward position with the 
Crows, or Power (they’re football teams!)  
As we spend longer in the same position on the computer, our arms 
fatigue and we end up shifting pressure further down the line. A 
good chair with arm rests is highly recommended as that will 
maintain good posture avoiding pinched nerves, tingly fingers and 
aches in the joints.  
This month’s exercises are Arm Raises, Elbow and Arm Shake Outs, 
and Elbow and Hand Pulls. These exercises encourage a bit of blood 
flow. It’s similar to when you sit in one position for too long and try 
to get up. Things tend to lock into position and refuse to do what is 
desired. When did you last try reading the newspaper cross-legged 
on the floor for half an hour and then get up? Now you know what I 
mean. Parts of your body get starved for blood so we need to 
remedy that every now and then. In your chair stretch your arms 
above your head and give them a bit of a shake and if you really 
have to yell out, ‘Go Crows/Power!’ Give your fingers a bit of a spin 
and twirl as you do it too.  
I used to do that at Tae Kwon Do before computers took over my 
life. Lower you arms towards the ground, stretch and shake again 
wriggling your fingers. Easy. Now the elbow exercises. Stretch one 
arm forward keeping it parallel with the ground and make a fist 

with your hand, thumb down. Bring your arm to your chest and 
stretch it forwards, back to your chest and forwards. Repeat a few 
times.  
Yes, do it with both arms even though you’re still hunting and 
pecking at your keyboard with one hand! You aren’t really are you? 
Are you?  
Next, still sitting in your chair with your arms in the ‘I am about to 
type position,’ bring just your hands up as if you’re signalling, 
‘Stop!’ Hold this position for a second or two. Lower them to the 
original typing position and hold and finally bring them all the way 
down and hold. Repeat.  
Describing these exercises would be so much easier if you just 
borrowed that CD.  
New exercise. Return to the ‘I am about to type position.’ Rotate 
your wrists so your palm faces the sky. Rotate them back to face the 
ground. Repeat.  
The idea here is the hands/arms are no longer doing repetitive 
tasks. The muscles are doing new things. Finally you need to nick 
off to Cunnos and buy a ‘Slinky’ and just move it from one hand to 
another.  
Why? Circulation. Grab the CD and have a look. I reckon those eight 
ball like ‘Health Balls’ you get with the intricate Chinese designs 
would be good too. They have a chime on the inside and look great 
plus you feel a bit like a magician manipulating them in your hand. 
According to the accompanying piece of paper they stimulate 
acupuncture points in the hand and aid blood flow helping make the 
bones stronger and keeps the mind sober and heaven knows we all 
need a bit more of that!  
From Apple Sauce  
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This story was printed from ZDNet Australia. 

Google takes searching personally 
 Matt Hines, Special to ZDNet Australia 
 March 30, 2004 
 URL: http://www.zdnet.com.au/news/business/0,39023166,39119007,00.htm 
As the search wars intensify, Google hopes that making a personal connection with its 
visitors will give it an edge.  
The company has launched a test version of its personalised search engine, part of its 
effort to tailor its search results to users' preferences. Google also plans to e-mail 
registered users of personalised search with the results of their queries.  
The U.S. California-based company introduced testing tools for its Personalized Web 
Search and Web Alerts on Google Labs, its public developmental playground.  
Google claims that the forthcoming search option will let users more quickly access 
preferred results. The e-mail alert is meant to complement the service by tracking specific 
topics and sending search results on a weekly or daily basis, depending on a user's 
request. Google representatives identified personalised search as an important step 
forward in the company's overall strategy of drawing itself closer to site visitors. 
 "Personalization and Web alerts are all examples of how we're continuing to innovate 
and provide value to users," said Jen Fitzpatrick, an engineering director at Google. This 
is the company's latest personalised service, meant to draw in people by helping them 
fine-tune their searches.  
The Web search giant previously unveiled Google Local, which aims to provide 
geography-specific search results, and also introduced its desktop toolbar search service. 
The company may also try to become more portal-like, with a "my" territory that 
competes with the personalised services of rival search engine Yahoo.  
Google recently updated a domain name registration of the Web address "MyGoogle.
com" with Network Solutions. Google's Personalized Web Search uses a series of check 
boxes to help users tailor their searches.  
Surfers can request a search on "bass" and then specify "fish" so that they do not get 
results related to music, for example. Google plans to include relevant information from 
its news pages and links back to its Froogle shopping site in its e-mails.  
Analysts welcomed Google's latest effort at personalisation, pointing out that the search 
and e-mail alerts differ significantly from the customised pages rival My Yahoo offers. 
Denise Garcia, an analyst at Stamford, Conn.-based research firm Gartner, called the beta 
"quintessential Google," observing that the company has always favoured a tight focus on 
providing search tools rather than other forms of customisable content, such as those 
found on My Yahoo.  
 

Garcia said she would like to see Google increase the complexity of personalisation it 
offers. The company could encourage greater use of the system by adding more depth in 
customization, such as providing more localised options and a larger range of buttons for 
finding content aimed at children and teenagers, she said.  
The system currently lets people highlight what state they're most interested in; by taking 
that down to the city or town level, Google could have even brighter prospects, according 
to Garcia. "I could see people using this as an alternative to existing yellow pages and 
directory listings, if Google pushes it to the metro level," Garcia said. "There's also a 
huge opportunity to attract more local advertisers when that happens, and as much as this 
is a tool that caters to end users, I think it plays very nicely into that equation." Google 
has yet to place ads on the personalisation site, as it is still in test mode, but Fitzpatrick 
said it will continue its company-wide effort to offer greater levels of relevancy to 
advertisers.  
The company has not given a launch date for a final version of the new tools.     
Copyright •0„8 2003 CNET Networks, Inc. All Rights Reserved.   
ZDNET is a registered service mark of CNET Networks, Inc.  
ZDNET Logo is a service mark of CNET NETWORKS, Inc.    

Avoid False Starts 
Some CD-ROMs launch a program automatically when 
you load them. If you often use one of these-the 
Windows CD-ROM, for example-to get data, you have 
to wait for the program to start and then close it. To 
avoid this, hold down the <Shift> key as you insert the 
CD-ROM. Another option is to open Device Manager 
(to find its tab, hold down <Alt> and double-click My 
Computer), double-click CDROM, double-click the 
drive name, click the Settings tab, and uncheck the Auto 
insert notification box. 
By Kirk Steers 
by Australian PC World © 2000 IDG Communications 


